WELINK CONFERENCING

Installation and User Guide
This guide covers the guidelines to be followed when deploying WeLink Conferencing. The User Guide portion provides the end user with basic instructions to follow on using the product. The Installation Guide is intended for System Administrators who will be setting up and managing the WeLink Conferencing hardware and software.
Notice

While reasonable efforts have been made to ensure that the information in this document is complete and accurate at the time of printing, Avaya assumes no liability for any errors. Avaya reserves the right to make changes and corrections to the information in this document without the obligation to notify any person or organization of such changes.

Documentation disclaimer

“Documentation” means information published in varying mediums which may include product information, operating instructions and performance specifications that are generally made available to users of products. Documentation does not include marketing materials.

Avaya shall not be responsible for any modifications, additions, or deletions to the original published version of Documentation unless such modifications, additions, or deletions were performed by or on the express behalf of Avaya. End User agrees to indemnify and hold harmless Avaya, Avaya’s agents, servants and employees against all claims, lawsuits, demands and judgments arising out of, or in connection with, subsequent modifications, additions or deletions to this documentation, to the extent made by End User.

Link disclaimer

Avaya is not responsible for the contents or reliability of any linked websites referenced within this site or Documentation provided by Avaya. Avaya is not responsible for the accuracy of any information, statement or content provided on these sites and does not necessarily endorse the products, services, or information described or offered within them. Avaya does not guarantee that these links will work all the time and has no control over the availability of the linked pages.

Warranty

Avaya provides a limited warranty on Avaya hardware and software. Refer to your sales agreement to establish the terms of the limited warranty. In addition, Avaya’s standard warranty language, as well as information regarding support for this product while under warranty is available to Avaya customers and other parties through the Avaya Support website: https://support.avaya.com/helpcenter/getGenericDetails?detailId=C20091120112456651010 under the link “Warranty & Product Lifecycle” or such successor site as designated by Avaya. Please note that if you acquired the product(s) from an authorized Avaya Channel Partner outside of the United States and Canada, the warranty is provided to You by said Avaya Channel Partner and not by Avaya.

“Hosted Service” means an Avaya hosted service subscription that You acquire from either Avaya or an authorized Avaya Channel Partner (as applicable) and which is described further in Hosted SAS or other service description documentation regarding the applicable hosted service. If You purchase a Hosted Service subscription, the foregoing limited warranty may not apply but You may be entitled to support services in connection with the Hosted Service as described further in your service description documents for the applicable Hosted Service. Contact Avaya or Avaya Channel Partner (as applicable) for more information.

Hosted Service

THE FOLLOWING APPLIES ONLY IF YOU PURCHASE AN AVAYA HOSTED SERVICE SUBSCRIPTION FROM AVAYA OR AN AVAYA CHANNEL PARTNER (AS APPLICABLE), THE TERMS OF USE FOR HOSTED SERVICES ARE AVAILABLE ON THE AVAYA WEBSITE, HTTPS://SUPPORT.AVAYA.COM/LICENSEINFO UNDER THE LINK “Avaya Terms of Use for Hosted Services” OR SUCH SUCCESSOR SITE AS DESIGNATED BY AVAYA, AND ARE APPLICABLE TO ANYONE WHO ACCESES OR USES THE HOSTED SERVICE. BY ACCESSING OR USING THE HOSTED SERVICE, OR AUTHORIZING OTHERS TO DO SO, YOU, ON BEHALF OF YOURSELF AND THE ENTITY FOR WHOM YOU ARE DOING SO (HEREAFTER REFERRED TO INTERCHANGEABLY AS “YOU” AND “END USER”), AGREE TO THE TERMS OF USE. IF YOU ARE ACCEPTING THE TERMS OF USE ON BEHALF A COMPANY OR OTHER LEGAL ENTITY, YOU REPRESENT THAT YOU HAVE THE AUTHORITY TO BIND SUCH ENTITY TO THESE TERMS OF USE. IF YOU DO NOT HAVE SUCH AUTHORITY, OR IF YOU DO NOT WISH TO ACCEPT THESE TERMS OF USE, YOU MUST NOT ACCESS OR USE THE HOSTED SERVICE OR AUTHORIZE ANYONE TO ACCESS OR USE THE HOSTED SERVICE.

Licenses

THE SOFTWARE LICENSE TERMS AVAILABLE ON THE AVAYA WEBSITE, HTTPS://SUPPORT.AVAYA.COM/LICENSEINFO, UNDER THE LINK “AVAYA SOFTWARE LICENSE TERMS (Avaya Products)” OR SUCH SUCCESSOR SITE AS DESIGNATED BY AVAYA, ARE APPLICABLE TO ANYONE WHO DOWNLOADS, USES AND/OR INSTALLS AVAYA SOFTWARE, PURCHASED FROM AVAYA INC., ANY AVAYA AFFILIATE, OR AN AVAYA CHANNEL PARTNER (AS APPLICABLE) UNDER A COMMERCIAL AGREEMENT WITH AVAYA OR AN AVAYA CHANNEL PARTNER. UNLESS OTHERWISE AGREED TO BY AVAYA IN WRITING, AVAYA DOES NOT EXTEND THIS LICENSE IF THE SOFTWARE WAS OBTAINED FROM ANYONE OTHER THAN AVAYA, AN AVAYA AFFILIATE OR AN AVAYA CHANNEL PARTNER; AVAYA RESERVES THE RIGHT TO TAKE LEGAL ACTION AGAINST YOU AND ANYONE ELSE USING OR SELLING THE SOFTWARE WITHOUT A LICENSE. BY INSTALLING, DOWNLOADING OR USING THE SOFTWARE, OR AUTHORIZING OTHERS TO DO SO, YOU, ON BEHALF OF YOURSELF AND THE ENTITY FOR WHOM YOU ARE INSTALLING, DOWNLOADING OR USING THE SOFTWARE (HEREAFTER REFERRED TO INTERCHANGEABLY AS “YOU” AND “END USER”), AGREE TO THESE TERMS AND CONDITIONS AND CREATE A BINDING CONTRACT BETWEEN YOU AND AVAYA INC. OR THE APPLICABLE AVAYA AFFILIATE (“AVAYA”).

Avaya grants You a license within the scope of the license types described below, with the exception of Heritage Nortel Software, for which the scope of the license is detailed below. Where the order documentation does not expressly identify a license type, the applicable license will be a Designated System License as set forth below in the Designated System(s) License (DS) section as applicable. The applicable number of licenses and units of capacity for which the license is granted will be one (1), unless a dif-
different number of licenses or units of capacity is specified in the documentation or other materials available to You. “Software” means computer programs in object code, provided by Avaya or an Avaya Channel Partner, whether as stand-alone products, pre-installed on hardware products, and any upgrades, updates, patches, bug fixes, or modified versions thereto. “Designated Processor” means a single stand-alone computing device. “Server” means a set of Designated Processors that hosts (physically or virtually) a software application to be accessed by multiple users. “Instance” means a single copy of the Software executing at a particular time: (i) on one physical machine; or (ii) on one deployed software virtual machine (“VM”) or similar deployment.

License types

Designated System(s) License (DS). End User may install and use each copy or an Instance of the Software only: 1) on a number of Designated Processors up to the number indicated in the order; or 2) up to the number of Instances of the Software as indicated in the order, Documentation, or as authorized by Avaya in writing. Avaya may require the Designated Processor(s) to be identified in the order by type, serial number, feature key, Instance, location or other specific designation, or to be provided by End User to Avaya through electronic means established by Avaya specifically for this purpose.

Concurrent User License (CU). End User may install and use the Software on multiple Designated Processors or one or more Servers, so long as only the licensed number of Units are accessing and using the Software at any given time. A “Unit” means the unit on which Avaya, at its sole discretion, bases the pricing of its licenses and can be, without limitation, an agent, port or user, an e-mail or voice mail account in the name of a person or corporate function (e.g., webmaster or helpdesk), or a directory entry in the administrative database utilized by the Software that permits one user to interface with the Software. Units may be linked to a specific, identified Server or an Instance of the Software.

Named User License (NU). You may: (i) install and use each copy or Instance of the Software on a single Designated Processor or Server per authorized Named User (defined below); or (ii) install and use each copy or Instance of the Software on a Server so long as only authorized Named Users access and use the Software. “Named User”, means a user or device that has been expressly authorized by Avaya to access and use the Software. At Avaya’s sole discretion, a “Named User” may be, without limitation, designated by name, corporate function (e.g., webmaster or helpdesk), an e-mail or voice mail account in the name of a person or corporate function, or a directory entry in the administrative database utilized by the Software that permits one user to interface with the Software.

Copyright

Except where expressly stated otherwise, no use should be made of materials on this site, the Documentation, Software, Hosted Service, or hardware provided by Avaya. All content on this site, the documentation, Hosted Service, and the product provided by Avaya including the selection, arrangement and design of the content is owned either by Avaya or its licensors and is protected by copyright and other intellectual property laws including the sui generis rights relating to the protection of databases. You may not modify, copy, reproduce, republish, upload, post, transmit or distribute in any way any content, in whole or in part, including any code and software unless expressly authorized by Avaya. Unauthorized reproduction, transmission, dissemination, storage, and or use without the express written consent of Avaya can be a criminal, as well as a civil offense under the applicable law.

Virtualization

The following applies if the product is deployed on a virtual machine. Each product has its own ordering code and license types. Note, unless otherwise stated, that each Instance of a product must be separately licensed and ordered. For example, if the end user customer or Avaya Channel Partner would like to install two Instances of the same type of products, then two products of that type must be ordered.

Third Party Components

“Third Party Components” mean certain software programs or portions thereof included in the Software or Hosted Service may contain software (including open source software) distributed under third party agreements (“Third Party Components”), which contain terms regarding the rights to use certain portions of the Software (“Third Party Terms”). As required, information regarding distributed Linux OS source code (for those products that have distributed Linux OS source code) and identifying the copyright holders of the Third Party Components and the Third Party Terms that apply is available in the products, Documentation or on Avaya’s website at: https://support.avaya.com/Copyright or such successor site as designated by Avaya. The open source software license terms provided as Third Party Terms are consistent with the license rights granted in these Software License Terms, and may contain additional rights benefiting You, such as modification and distribution of the open source software. The Third Party Terms shall take precedence over these Software License Terms, solely with respect to the applicable Third Party Components to the extent that these Software License Terms impose greater restrictions on You than the applicable Third Party Terms.

The following applies only if the H.264 (AVC) codec is distributed with the product. THIS PRODUCT IS LICENSED UNDER THE AVC PATENT PORTFOLIO LICENSE FOR THE PERSONAL USE OF A CONSUMER OR OTHER USES IN WHICH IT DOES NOT RECEIVE REMUNERATION TO (i) ENCODE VIDEO IN COMPLIANCE WITH THE AVC STANDARD (“AVC VIDEO”) AND/OR (ii) DECODE AVC VIDEO THAT WAS ENCODED BY A CONSUMER ENGAGED IN A PERSONAL ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO PROVIDER LICENSED TO PROVIDE AVC VIDEO. NO LICENSE IS GRANTED OR SHALL BE IMPLIED FOR ANY OTHER USE.
Service Provider

THE FOLLOWING APPLIES TO AVAYA CHANNEL PARTNER'S HOSTING OF AVAYA PRODUCTS OR SERVICES. THE PRODUCT OR HOSTED SERVICE MAY USE THIRD PARTY COMPONENTS SUBJECT TO THIRD PARTY TERMS AND REQUIRE A SERVICE PROVIDER TO BE INDEPENDENTLY LICENSED DIRECTLY FROM THE THIRD PARTY SUPPLIER. AN AVAYA CHANNEL PARTNER'S HOSTING OF AVAYA PRODUCTS MUST BE AUTHORIZED IN WRITING BY AVAYA AND IF THOSE HOSTED PRODUCTS USE OR EMBED CERTAIN THIRD PARTY SOFTWARE, INCLUDING BUT NOT LIMITED TO MICROSOFT SOFTWARE OR CODECS, THE AVAYA CHANNEL PARTNER IS REQUIRED TO INDEPENDENTLY OBTAIN ANY APPLICABLE LICENSE AGREEMENTS, AT THE AVAYA CHANNEL PARTNER'S EXPENSE, DIRECTLY FROM THE APPLICABLE THIRD PARTY SUPPLIER.

WITH RESPECT TO CODECS, IF THE AVAYA CHANNEL PARTNER IS HOSTING ANY PRODUCTS THAT USE OR EMBED THE G.729 CODEC, H.264 CODEC, OR H.265 CODEC, THE AVAYA CHANNEL PARTNER ACKNOWLEDGES AND AGREES THE AVAYA CHANNEL PARTNER IS RESPONSIBLE FOR ANY AND ALL RELATED FEES AND/OR ROYALTIES. THE G.729 CODEC IS LICENSED BY SIPRO LAB TELECOM INC. SEE WWW.SIPRO.COM/CONTACT.HTML. THE H.264 (AVC) CODEC IS LICENSED UNDER THE AVC PATENT PORTFOLIO LICENSE FOR THE PERSONAL USE OF A CONSUMER OR OTHER USES IN WHICH IT DOES NOT RECEIVE REMUNERATION TO: (I) ENCODE VIDEO IN COMPLIANCE WITH THE AVC STANDARD ("AVC VIDEO") AND/OR (II) DECODE AVC VIDEO THAT WAS ENCODED BY A CONSUMER ENGAGED IN A PERSONAL ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO PROVIDER LICENSED TO PROVIDE AVC VIDEO. NO LICENSE IS GRANTED OR SHALL BE IMPLIED FOR ANY OTHER USE. ADDITIONAL INFORMATION FOR H.264 (AVC) AND H.265 (HEVC) CODECS MAY BE OBTAINED FROM MPEG LA, L.L.C. SEE HTTP://WWW.MPEGLA.COM.

Compliance with Laws

You acknowledge and agree that it is Your responsibility for complying with any applicable laws and regulations, including, but not limited to laws and regulations related to call recording, data privacy, intellectual property, trade secret, fraud, and music performance rights, in the country or territory where the Avaya product is used.

Preventing Toll Fraud

“Toll Fraud” is the unauthorized use of your telecommunications system by an unauthorized party (for example, a person who is not a corporate employee, agent, subcontractor, or is not working on your company's behalf). Be aware that there can be a risk of Toll Fraud associated with your system and that, if Toll Fraud occurs, it can result in substantial additional charges for your telecommunications services.

Avaya Toll Fraud intervention

If You suspect that You are being victimized by Toll Fraud and You need technical assistance or support, call Technical Service Center Toll Fraud Intervention Hotline at +1-800-643-2353 for the United States and Canada. For additional support telephone numbers, see the Avaya Support website: https://support.avaya.com or such successor site as designated by Avaya.

Security Vulnerabilities

Information about Avaya's security support policies can be found in the Security Policies and Support section of https://support.avaya.com/security.

Suspected Avaya product security vulnerabilities are handled per the Avaya Product Security Support Flow (https://support.avaya.com/css/P8/documents/100161515).

Downloading Documentation

For the most current versions of Documentation, see the Avaya Support website: https://support.avaya.com, or such successor site as designated by Avaya.

Contact Avaya Support

See the Avaya Support website: https://support.avaya.com for product or Hosted Service notices and articles, or to report a problem with your Avaya product or Hosted Service. For a list of support telephone numbers and contact addresses, go to the Avaya Support website: https://support.avaya.com (or such successor site as designated by Avaya), scroll to the bottom of the page, and select Contact Avaya Support.

Trademarks

The trademarks, logos and service marks ("Marks") displayed in this site, the Documentation, Hosted Service(s), and product(s) provided by Avaya are the registered or unregistered Marks of Avaya, its affiliates, its licensors, its suppliers, or other third parties. Users are not permitted to use such Marks without prior written consent from Avaya or such third party which may own the Mark. Nothing contained in this site, the Documentation, Hosted Service(s) and product(s) should be construed as granting, by implication, estoppel, or otherwise, any license or right in and to the Marks without the express written permission of Avaya or the applicable third party.

Avaya is a registered trademark of Avaya Inc.

All non-Avaya trademarks are the property of their respective owners. Linux® is the registered trademark of Linus Torvalds in the U.S. and other countries.
## Table of Contents

### USER GUIDE
1. **INTRODUCTION**
   - Maximum Number of Participants
   - Access Codes (Logging into Conference Server)
   - Conference Room Navigation
2. **MODERATOR’S FUNCTIONS**
   - Invitation
   - Additional Moderator Functions
3. **SPEAKER’S FUNCTIONS**
4. **LISTENER’S FUNCTIONS**
5. **ADDED FUNCTIONS FOR AVAYA OFFICE LINX INTEGRATION**

### INSTALLATION GUIDE
1. **WE LINK CONFERENCING LICENSE**
   - License Expiry Notice
   - License Activation
   - Requirements
   - Procedure
2. **WE LINK CONFERENCING INSTALLATION**
   - Requirements
   - Step-by-Step Installation Instructions
3. **WE LINK CONFERENCING MONITOR**
   - Overview
   - Monitor Screen
4. **WE LINK CONFERENCING FAQ**
   - Licensing
   - Troubleshooting
Introduction

WeLink Conferencing allows users to have a conference call or a voice meeting over a pre-existing telephone system. Once all the server side configurations have been completed by the system administrator, the person who has the Moderator access code will have the ability to control the different rooms in the conference system. The Moderator can be seen as the conference room's chairperson who has the ability to invite other participants to the conference. The Moderator may also modify different types of settings that are related to the conference rooms such as the recording functions or the background music.

This guide is intended for the end-users of the WeLink Conferencing.

Maximum Number of Participants

There are 3 types of participants within WeLink Conferencing: Moderators, Speakers, and Listeners.

**Moderator (Chair):** The moderator creates the conference room. The moderator also controls access to the room, who can speak, and when.

**Speaker (Attendee):** These participants can listen to the conversation, and can contribute through voice input.

**Listener:** Participants who are listeners can hear what is said, but cannot themselves speak in the room.

WeLink Conferencing supports up to 100 channels (total simultaneous participants) across all rooms.

A single conference room can have up to 100 participants, providing no more than 50 are speakers. All other participants must be listeners only.

For example:

<table>
<thead>
<tr>
<th>MAXIMUM PARTICIPANTS - ONE ROOM</th>
</tr>
</thead>
<tbody>
<tr>
<td>Moderator</td>
</tr>
<tr>
<td>Speaker</td>
</tr>
<tr>
<td>Listener</td>
</tr>
<tr>
<td>Total</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>MAXIMUM PARTICIPANTS - MULTIPLE ROOMS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Room Number</td>
</tr>
<tr>
<td>Moderator</td>
</tr>
<tr>
<td>Speaker</td>
</tr>
<tr>
<td>Listener</td>
</tr>
<tr>
<td>Total</td>
</tr>
</tbody>
</table>

There is no limit to the number of conference rooms that can be created, providing the total number or participants from all rooms does not exceed 100.
Access Codes (Logging into Conference Server)

WeLink Conferencing can have multiple rooms active by default. Your system Administrator can add more rooms and also change the maximum number of participants in each of the rooms. The system Administrator also assigns the access codes, which are currently set as follows:

- Room 1 - ___ participants max.
  Moderator access code: ________
  Participant access code: ________

- Room 2 - ___ participants max.
  Moderator access code: ________
  Participant access code: ________

To enter a room simply dial the number for the conference server then enter the access code you are given. For example, if you are the Moderator of the room and are given the access code 1111#, enter the code once you are connected to the conference server. The server will automatically send you to your room and grant you Moderator authority.

The process is identical for both participants and listeners. The only difference will be the access code that they are given. Since the access codes themselves are associated with the conference room, there is no need to specify which main conference room you wish to join.

**Warning:** When dialing into the conference server from outside the company, you must dial the conference server’s external number directly. Do not connect through the auto attendant or you may not be connected.

Conference Room Navigation

While the main conference rooms are determined by the access code, you will have the ability to enter the side rooms off the main conference room.

Each conference room has 4 side or private rooms to allow a side conference. The following codes can be used to access each of the private rooms:

- 51# enter side conference room 1
- 52# enter side conference room 2
- 53# enter side conference room 3
- 54# enter side conference room 4
- 50# to return to the main conference.
Moderator’s Functions

The moderator has administrative rights inside a conference room.

**Note**: Moderators also have access to Speaker's Functions on page 12.

Invitation

The Moderator can invite participants to the conference. Please view the following example to get an idea of how the procedure takes place.

1. Press 2# from your telephone. You will be prompted to enter a number.
2. Enter the full number (at this time, there is no dial plan logic or contact integration), including a leading 9, and a call will be placed to the number.
   - If the call is unsuccessful, the chairman will hear a prompt indicating the failure.
   - If the call is successful the participant will be added to the conference room.

**Note**: This whole process is silent to the other participants so you don't have to worry about them hearing the digits pressed.

**Note**: You can also enter a side or private room and then invite a participant if you wish to prep them on the call before joining the main conference.

**Note**: To cancel an invitation call in progress, the Moderator can enter 20#.

Additional Moderator Functions

- 30# - Turn off background music
- 31# - 39# - Change background music (1 - 9), also enables music if it has been turned off.
- 71# - Recording off
- 81# - Recording on
- 72# - Announcements off
- 82# - Announcements on
Speaker’s Functions

These are the basic functions available to a speaker.

- 41# - Plays your Party ID, i.e. if you were the first caller it would play 1.
- 42# - Plays your Caller ID, i.e. the phone number you called from
- 43# - Plays the number of parties currently in the conference
- 44# - Plays the maximum number of parties for this conference
- 88# - Mute
- 78# - Un-Mute
- 21# - Hand off Call to another number
- 9# - A help file outlining the options will be played (currently this file is not available)
- 0# - Return to main menu

**Note:** Played messages are only heard by that caller, and not by the whole room.

Listener’s Functions

Listeners do not have any functions available to them.

Added Functions for Avaya Officelinx Integration

These are the advanced functions available in WeLink Conferencing.

- **Play Caller ID of Participant:** The Caller ID information is used to identify the participant when he/she enters the conference room.
- **Integration with contacts:** The Caller ID can be crossed referenced with the contact list to name the participant automatically based on the information.
- **Speaker Marker During Record:** This feature automatically creates a marker on the recorded file which allows you to see who was speaking at any given moment.
- **Transcribe Conference Option:** This feature allows you to send the recorded conference call to the transcription service so that you can receive a printout of the conversation.
- **Conference Report:** This feature creates a log of all conferences and their participants (Who joined, when they joined, when they left).
- **E-mail Summary Report:** This feature automatically sends a log to the conference organizer. The information included in the log includes the number of participants, their caller id, and the duration of the conversation.
WeLink Conferencing License

In order to run the WeLink Conferencing, you must obtain a license from an authorized dealer. It is recommended that you have an Internet connection on the computer that will host WeLink Conferencing. The License requires an Internet connection to activate the conference server upon installation.

License Expiry Notice

When the license for WeLink Conferencing is about to expire, the server will play a prompt for the moderator upon login as a reminder. This prompt is only played for moderators. Participants and listeners will not hear the notice.

The notice is played under following conditions:

- 30 Days before Expiry
- 15 Days before Expiry
- 7 Days before Expiry
- 1 Day before Expiry
- The day of Expiry

When the license expires, no users will be able to connect to the conference server. To ensure seamless usage and integration of WeLink Conferencing, contact your dealer regarding license renewal as soon as possible.
License Activation

Requirements

- Internet Connection
- Site UID
- Serial Number

**Warning:** If you are installing the conference server on an Officelinx system, ensure that you are not running the Officelinx License Upgrade program when managing your license. You should always confirm that you are running the **Conference Server license program**.

Procedure

1. Contact your dealer and place an order. Once the order is finalized you will receive two codes. First is the **Site UID**, and the second is the product **Serial Number**.

   **Warning:** Site UID and the Serial number are vital and confidential. Keep a record of these numbers in a safe place.

   **Note:** You can install the WeLink Conferencing without the license. You are free to load your license at a later time if it is unavailable during installation. Once you do install the license onto your system, you must restart the UC Conf Server service from Control Panel > Administrative Tools > Services.

2. Download the WeLink Conferencing installation program by using the link provided by your dealer. During the installation, or when you run the license upgrade program separately, you will be prompted with the following window. Enter the information in the highlighted area then click on the **Request Online Activation** button.

   **Warning:** An Internet connection is required to activate the license.

3. The license is now active on the server computer.

   **Hint:** For detailed instructions, refer to page 15.
WeLink Conferencing Installation

**Note:** You can install the Esna WeLink Conferencing without the license. You are free to load your license at a later time if it is unavailable during installation. Once you do install the license onto your system, you must restart the UC Conf Server service from Control Panel > Administrative Tools > Services.

**Warning:** If you are upgrading WeLink Conferencing from an older version and have made changes on the SIP Configuration Tool during initial installation, you must select the template for your PBX again from the SIP Configuration Tool so that the settings are refreshed during the upgrade. All of your previous channel/extension settings and room settings will remain even if you reselect the template. After re-selecting the template, you can modify the entries to fit your needs. This is particularly important for Iwatsu systems.

**Warning:** By default, WeLink Conferencing uses port 50060 for communicating with the PBX (different from the 5060 default of Avaya Officelinx to avoid conflict). While this does not affect the configurations of most sites, it may be necessary to allow access to that port through network security. Be particularly aware of port usage on sites that have a Dialogic Media Gateway, since that port is often blocked by default.

**Warning:** When dialing into the conference server from outside the company, dial the conference server’s external number directly. Do not connect through the auto attendant or you may not be connected.

**Requirements**

- Microsoft .Net Framework 2.0 (this is included in the WeLink Conferencing installer)
- SIP Integration
- Internet Connection (for license activation)
- WeLink Conferencing supports up to 100 channels.
Step-by-Step Installation Instructions

1. Locate and run the WeLink Conferencing installation file. The following screen will appear.
   Click **Next** to continue.

2. Click **Next** to start the installation.

3. The installation will begin.

4. At this point, if you do not have Microsoft .Net Framework 2.0 on your system, the WeLink Conferencing installer will automatically add it. This process may take a while.
5. During the installation, the SIP Configuration Tool will appear. Configure SIP to reflect your own system. Most fields will be automatically populated if you used the provided templates available under the File menu.

WeLink Conferencing supports up to 100 channels.

Once all the fields are completed, click on the Conference option from the left menu.

**Warning:** If you are upgrading WeLink Conferencing from an older version and have made changes on the SIP Configuration Tool during initial installation, you must select the template for your PBX again from the SIP Configuration Tool so that the settings are refreshed during the upgrade. All of your previous channel/extension settings and room settings will remain even if you reselect the template. After re-selecting the template, you can modify the entries to fit your needs. This is particularly important for iwatsu systems.

6. You can configure the conferencing settings here. This section is particularly important when integrating with the Officelinx system. The other field that will be commonly used is the Language selector. The language defined here will change the prompts that are played for the users when they dial into the conference server. For example, if you choose Japanese, the default prompts that the users will hear right after they dial into the conference server will be in Japanese. Please note that you must assign a language to the rooms separately if you want the prompts inside the rooms to be set to a different language. Configure the remaining fields as required then click on the Rooms option from the left menu.

7. You will be able to configure your conference rooms here. Enter the number of rooms that you will be using and configure each room accordingly. Click OK when you are finished. Each of these options is detailed below.

- **Max Parties:** Maximum number of participants that can be in the room simultaneously.
- **Chairman PIN:** Password required for Moderator Access.
- **Listener only PIN**: Password required for Listener Access.
- **Attendee PIN**: Password required for Speaker access.
- **Mailbox**: Enter the Mailbox that will receive the reports for the current room, this feature is only available with Officelinx integration.
- **Music**: Choose the background music that is played when only 1 person is in a room.
- **Announce**: Make an announcement to everyone in the room whenever someone else joins the room.
- **Recording Type**: Select from one of the following recording options,
  - **Disabled**: Recording the conference is disabled.
  - **Automated (2 parties)**: Conference server will automatically record the session when two or more participants are in the room.
  - **Automated (2 parties one is chairman)**: Conference server will automatically record the session when two or more participants are in the room, but one of the participants must be a moderator.
  - **Manual**: The moderator may manually start/stop the recording.
- **Language**: Select the language for the current room. This selection will change all the prompts played in the current room to the language selected.
- **Access Type**: This option determines how users are admitted to the room.
  - **Anyone with PIN**: Users with a PIN will be immediately admitted to the room.
  - **Chairman must be present**: Conference participants can log in but will not be admitted to the room until the Moderator also logs in. Until then, users will hear wait music and cannot communicate with each other.
  - **Caller ID must be in the access list**: (for future release) An INI file can be modified to add a list of telephone numbers that are allowed access to this room. Any calls from numbers not on the list will not be allowed into that room.

**Note**: Recording Type setting is unavailable for Iwatsu PBX systems.

**Note**: If there is no Avaya Officelinx integration, the conference sessions that are recorded will be stored as voice files under the conference server installation folder (c:\uc\conference\recording\roomX\ by default. X represents room number).
8. After the SIP configuration, you must add the license for the WeLink Conferencing server. An Internet connection is required to activate your license.

- Please refer to License Activation on page 14

Note: If you don't have the license ready during installation, simply click on the Close button to finish the installation without the license. When you receive the license information at a later time, you can update your license from the utility located at Start > Programs > WeLink Conference Server > CS License Upgrade. Refer to License Activation on page 14 for detailed information.

Warning: If you are installing the conference server on an Avaya Officelinx system, ensure that you are not running the Officelinx License Upgrade program when managing your license. You should always confirm that you are running the Conference server license program.

9. When licensing is complete, you will see the following window. Click Finish to exit the installer.

10. You will be asked to restart the computer.

    Click OK to restart the system.

    The installation of WeLink Conferencing is complete.
WeLink Conferencing Monitor

Overview

WeLink Conferencing has a built-in capability to display the current status of the server through a web interface. By logging into port 30060 of the conference server (e.g. http://192.168.1.100:30060), the technicians or the administrators will be able to view live information regarding the server. The information available from the monitor is as follows:

- List of rooms
- Number of Users in each room
- Recent activities of the room
- Status of the room

**Miscellaneous information regarding rooms**
- (e.g. Mailbox that it is attached to for Avaya Officelinx integration, etc.)
Monitor Screen

When you type in the correct address for the monitor, you will see a screen similar to the one below. Each row represents a single room in the conference server while each column contains data specific to that room.

- **Listeners**: This field shows the number of listeners in a room.
- **Speakers**: This field shows the number of speakers (regular participants) in a room.
- **Total**: This field shows the total number of people in a room.
- **Mbx#**: This field shows the mailbox associated with room (for Avaya Officelinx integration).
- **Started**: This field shows the time at which the conference started.
- **Ended**: This field shows the time at which the conference ended.
- **Locked**: This field shows the locked status of the room.
- **Recording**: This field shows if the room is currently being recorded or not.
- **AN**: Announcement. This field shows if the announcements are on or off.
- **AT**: Announcement Type. This field shows what type of announcements are being played.
- **PR**: Private Rooms. This field shows if private rooms are enabled in the room.
- **PHP**: Play Help Prompt. This field shows if help prompts are on or off.

When a room is in use, it will be displayed highlighted on monitor as you can see below. When the room is being used, you will be able to see the number of users in that room and also see when the conference started.

When the conference is over the highlight will disappear. At this point the **Ended** status of the conference room will be updated with the end time information so that you can see exactly when the conference started & ended.

You may also click on the room number to view the specifics of that room. This will provide you with the participant's information, such as Caller ID and name if the contact information is available in the WeLink Conferencing integrated...
environment.

<table>
<thead>
<tr>
<th>ID</th>
<th>Caller Id</th>
<th>Caller name</th>
<th>Channel</th>
<th>Type</th>
<th>State</th>
<th>Joined</th>
</tr>
</thead>
<tbody>
<tr>
<td>0001</td>
<td>350</td>
<td>HoY, Sebastian</td>
<td>013</td>
<td>00</td>
<td>06</td>
<td>2009/06/29 15:24:29</td>
</tr>
</tbody>
</table>

*Rooms* - Copyright © 2009 Conference server
WeLink Conferencing FAQ

Licensing

Q: Can I use one WeLink Conferencing license on multiple servers?
A: No. You must obtain a license for each server.

Q: Can I move the WeLink Conferencing license to another server?
A: Yes, but you must obtain a new license for the new server from your dealer. The old license will no longer be valid. You will be allowed one hardware change free of charge. The license will be reissued to accommodate your hardware change. Subsequent hardware changes will incur an administration fee.

Q: What happens if there is a significant hardware change to the server?
A: You will be allowed one hardware change free of charge. The license will be reissued to accommodate your hardware change. Subsequent hardware changes will incur an administration fee.

Q: Can I pay for the WeLink Conferencing license month-to-month?
A: No, you must pay for the WeLink Conferencing license a year at a time.

Q: Can I add more features to the WeLink Conferencing license?
A: Yes. You may contact your dealer to upgrade your license for additional features. The license can be upgraded through the License Upgrade tool once you receive the details from your dealer.

Q: What if I add more features midway through my 1 year term?
A: You will be charged for the 1 year term on any type of feature upgrade but it will expire at the same time as your initial order.

Troubleshooting

Q: The server stopped working.
A: The most common causes are:

- **Server Computer Crash**: Restart the server computer. If the conference server isn't functional after the restart, consider one of the below scenarios.
- **No Internet Connection**: WeLink Conferencing requires an Internet connection for its online license. Restore the Internet connection and the server should be functional soon after.
- **License Expiry**: WeLink Conferencing will cease to function when the license expires. Contact your dealer to renew the product license.
- **License Conflict**: The license is in use on another server. Contact your dealer.
- **Change in Server**: The hardware / software on the server has significantly changed. Obtain an updated license from your dealer.